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OVERVIEW

This User Guide is an overview to understand how to access the iSupplier Portal, navigate through the system and

understand the notification sent from the automatic system email notification to the company’s iSupplier users.

HOW TO USE THIS USER GUIDE

If familiar with the iSupplier Portal Functionalities and the CRC process, refer to the Three-Page Quick Reference

(Cheat sheet) on page 2 – 4. Otherwise, review the Process Overview section to better understand the processes.

Next, review the Content/Checklist section, as this section lists the required and optional steps for each of the

processes. Last, complete the required steps according to the detailed written instructions which follow the

numbering sequence shown in the screenshots for how each of the tasks shall be executed. When completing the

steps in the iSupplier Portal, you may refer to the Content/Checklist column to validate that the required steps

have been completed. In addition, this User Guide provides high-lighted and / or framed notes, tips and important

messages to assist you in some tasks.

PROCESS OVERVIEW

This User Guide describes how iSupplier users can access the iSupplier Portal, change passwords as needed, and

understand the different responsibilities available in the portal. Also, describes the information available in the

portal to understand the iSupplier Portal navigation and the notifications sent from the system to Suppliers.



CALIFORNIA RESOURCES CORPORATION AND ITS AFFILIATES (COLLECTIVELY, CRC)

User Guide – Overview to Access, Passwords, Navigation
and Notifications

Version 1.0

December 1, 2014

Intellectual property restrictions. CRC proprietary information. Page 2 of 39

QUICK REFERENCE (CHEAT SHEET)

This Quick Reference describes how to access key iSupplier Portal functionality.

Action Tab /Screen Quick Reference

Reset Password Login Screen

• Click on the “Login Assistance” hyperlink.
• In the “User Name” field, enter your User Name to access the iSupplier Portal.
• Click on the “Forgot Password” button to reset your Password. This will prompt an email

with instructions to be sent automatically to the email address associated with the
Username (this may take up to an hour).
 In the email, click on the “iSupplier Portal” hyperlink you will be taken automatically to

the “Change Password” screen.

Get User Name Login Screen

• Click on the “Login Assistance” hyperlink.
• In the “Email” field, enter the email address associated with your account (the email used

in registration).
• Click on the “Forgot User Name” button. Your User Name will be emailed to you.

Change
Password

General
Preferences

• Click on the “Preferences” hyperlink in the top right corner of the screen. This will take you
to the “General Preferences” screen.

• Change your password at any time in the “Change password” section.

Notifications
Settings

General
Preferences

IMPORTANT: This setting does not affect whether notifications are generated or displayed in
the iSupplier Portal.
• Click on the “Preferences” hyperlink in the top right corner of the screen. This will take you

to the “General Preferences” screen.
• In the “Notifications” section, select how you want to receive your e-mail notifications

from the “Email Style” dropdown menu.

Access to a
Specific
Responsibility

Home

IMPORTANT: The “Oracle Application Home Page” screen will be displayed only if more than
one responsibility has been assigned to the user. Otherwise, the iSupplier “Home” tab will be
shown immediately.
 There are five different responsibilities used in navigating in the iSupplier Portal:
 Supplier Security Administrator: This responsibility allows the User to access the

“Admin” tab.
 Supplier User – Registration: This is a temporary responsibility to complete the Supplier

registration and qualification process.
 Supplier User - Full View: This responsibility allows the User to access all available tabs

within the portal.
 Supplier User – Transactions: This responsibility allows the User to access all available

tabs within the portal, except administering Supplier users and Supplier profile data.
 Supplier User - Finance View: This responsibility allows the User to view invoices and

payment information.
 Supplier User - Invoicing: This responsibility allows the User to create/view invoices and

credit memos, and also view payment information.
 Click on the applicable responsibility hyperlink.

Notifications Home

IMPORTANT: iSupplier users simultaneously receive notifications by email and in the
iSupplier Portal. To respond to a Notification sent by email, click on the “Negotiation Details”
hyperlink. This will bring you to the iSupplier Portal “Login” screen.
• In the “Worklist” section, find the list of your pending notifications.
• To display all your notification, click on the “Full List” button.
• To see the details of a notification, click on the “Notification Subject” hyperlink.
• Notifications do not provide all the data or functionality to fully satisfy the requirement. To

execute the action, go to the specific screen.
• Do not click on the “Actions” button on the notifications.

Notification
Delegation -
Grant Work List

Home
• In the “Notifications” section, click on the “Full List” button to share all or just specific

notifications with someone else.
• Click on the “Worklist Access” hyperlink at the bottom of the screen, and then click on the
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Action Tab /Screen Quick Reference
Access “Grant Worklist Access” button.

• Populate the required fields.
• In the “Grant Access to” section, select from the following:
 “All Item Types” radio button: To share all your notifications with someone else.
 “Selected Item Types” radio button: To specify which notification will be shared.
 If you have not granted access to All Item Types, to specify which types of notifications

will be shared, in the “Available Item Types” box, select the notification types to share
by clicking on the appropriate types.

 Click on the “Move Arrow” icon to transfer the item to the “Selected Item Types” box.
• Click on the “Apply” button.

Notification
Delegation –
Vacation Rules

Home

• In the “Notification” section, click on the “Full List” button to auto respond or redirect
notifications within your organization during times when you will not be available to
respond to notifications

• Click on the “Vacation Rules” hyperlink at the bottom of the screen, and then click on the
“Create Rule” button.

• Click in the “Item Type” dropdown menu and select the type of notification that will be
rerouted. And then click the “Next” button.

• In the “Notification” option, select:
 “All”: To delegate/transfer all notifications related to the selected notification type.
 “Select”: To delegate/transfer selected notifications.
 Click on the “Next” button.

• Populate all the required fields. Then click on the “Apply” button.

Search Option Home

• Choose the type of search from the dropdown menu (i.e.: Purchase orders, Shipments,
Invoices, and Payments).

• In the empty box, enter the document number or “%” symbol (this will broaden the
searching results in any searching criteria).

• Click on the “Go” button to begin the search.

View Product
Information

Product
• Click on the “Supplier Items” hyperlink.
• Populate search criteria in the “Simple Search” section and click on the “Go” button.

View Consigned
Inventory Product

• Click on the “Consigned Inventory” hyperlink.
• Populate search criteria in the “Simple Search” section and click on the “Go” button.
• To view the number of days an item has aged through CRC’s transactions related to your

company’s consigned products, click on the “Consigned Inventory Aging” hyperlink.
 Select the number of days the item has aged from the “View” dropdown menu, and

then click on the “Go” button to display the information.

View and
Update
Attachments

Admin
• To view specific attachment content click on the attachment “Title” hyperlink in the

“Attachments” section.
• To update an attachment, click the “Update” pencil icon in the “Update” column.

Add
Attachments

Admin

• Click on the “Add Attachment” button.
 Enter the attachment name in the “Title” field, and provide a brief description of the

attachment in the “Description” field.
 Select the option “From Supplier” from the “Category” dropdown menu.
 Select the type of file you are about to attach by clicking on the “Type” radio button, and

then click on the “Apply” button to upload the attachment.

View
Organization
Details

Admin • Click on the “Organization” hyperlink in the “Profile Management” navigation panel.

View Addresses Admin

• Click on the “Address Book” hyperlink in the “Profile Management” navigation panel.
• To view a detailed information about the company’s address, click on the on the “Pencil”

icon in the “Update” column.
 RFQ Only Address: Address (and email address) used only to receive sourcing documents

such as Request for Information, Request for Quotation and/or Auctions.
 Purchasing Address: Address (and email address) to receive sourcing document such as

Request for Information, Request for Quotation and/or Auctions and purchasing
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Action Tab /Screen Quick Reference
document such as Purchase Order, Service Orders or Contracts.

 Payment Address: Address (and email address) to receive payments. Electronic
payments require the physical address of your company (and email address).

View Contacts Admin
IMPORTANT: Contacts can only be updated by the Supplier security Administration in your
company.
• Click on the “Contact Directory” hyperlink in the “Profile Management” navigation panel.

View Products
and Services

Admin

• Click on the “Products and Services” hyperlink in the “Profile Management” navigation
panel. This screen provides information about your company’s registered products and
services according to CRC-selected UNSPSC (United Nations Standard Products and Services
Code) codes and descriptions at the class level. For more information regarding UNSPSC
codes, visit www.unspsc.org.

View Banking
Details

Admin

• Click on the “Banking Details” hyperlink in the “Profile Management” navigation panel.
• To view all bank accounts select “All Accounts” in the “View” dropdown menu.
• Click on the “Go” button. The primary data for all bank accounts will be shown
• To view details about a specific bank account, click on the “Pencil” icon in the "Update”

column.

View Payments
and Invoicing
Preferences

Admin

• In the “Admin” tab, click on the “Payments and Invoicing” hyperlink in the “Profile
Management” navigation panel.

• Search for a specific information about your company’s payment and invoicing preferences
in the “Search” section. Entering the address name in the “Address Name” field and click on
the “Go” button.
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CONTENT / CHECKLIST

Steps Page No Required Check

1. Login, Username, Passwords, Access And Preferences Setup 6 Required

1.1. Login to the iSupplier Portal 6 Required

1.2. Recover User Name and Password – Login Assistance 8 Optional

1.3. Define Main Preferences 12 Optional

1.3.1. Change Password 13 Optional

1.3.2. Notifications Settings 14 Optional

2. Oracle Application Home Page 15 Required

2.1. Access to a Specific Responsibility 15 Required

2.2. Responsibilities Available for iSupplier Portal Users 16 Required

3. Notifications 17 Optional

3.1. Types of Notifications 18 Optional

3.2. View Notifications Details 20 Optional

3.3. Supplier Actions According To the Notification Received 21 Optional

3.4. Notification Delegation – Grant Worklist Access 22 Optional

3.5. Notification delegation – Vacation Rules 24 Optional

4. Navigation 26 Optional

4.1. Home Tab 26 Optional

4.1.1. Search Option 27 Optional

4.2. Orders Tab 27 Optional

4.3. Shipments Tab 28 Optional

4.4. Negotiations Tab 28 Optional

4.5. Finance Tab 28 Optional

4.6. Product Tab 28 Optional

4.6.1. View Product Information 28 Optional

4.6.2. View Consigned Inventory 29 Optional

4.6.3. View Consigned Inventory Aging 30 Optional

4.7. The Admin Tab 30 Optional

4.7.1. Access Admin Tab - View General Information 31 Optional

4.7.2. Search And Update Attachments 32 Optional

4.7.3. Add Attachment 33 Optional

4.7.4. View and Update the Organization Information 34 Optional

4.7.5. View the Address Book 35 Optional

4.7.6. View the Contact Directory 36 Optional

4.7.7. View Products and Services 36 Optional

4.7.8. View Banking Details 37 Optional

4.7.9. View Payments and Invoicing Preferences 39 Optional
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INSTRUCTIONS

1. LOGIN, USERNAME, PASSWORDS, ACCESS AND PREFERENCES SETUP

1.1. LOGIN TO THE ISUPPLIER PORTAL

When the Supplier has registered users in the iSupplier Portal, an automatic email notification is sent to confirm

the registration in the iSupplier Portal with the Username, temporary password and a link to access the iSupplier

Portal. The first login will require you to change your password for security purposes.

( 1 ) You need to save the assigned Username as you will need that each time you login in the iSupplier Portal.

( 2 ) You will use the temporary password to log in to the iSupplier Portal.

( 3 ) Click on the “Log on” hyperlink to access the iSupplier Portal.

( 4 ) In the “User Name” field, enter the Username provided in the registration confirmation email.

( 5 ) In the “Password” field, enter the temporary password provided in the registration confirmation email.

Note: This field is case sensitive.

( 6 ) Click on the “Login” button. If login is successful, the system will prompt to change your password.

Note: If login the portal fails, use the “Login Assistance” hyperlink, see the next section for more information.
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( 7 ) In the “Current Password” field, enter the temporary password as provided in the confirmation of registration

email.

( 8 ) In the “New Password” field, enter the desired password. The new Password must have the following

characteristics:

 Must be a Minimum of 8 characters in length.

 Must have at least 1 number.

 Must have at least 1 character.

 Can not have repeating characters or numbers. (i.e. it can not have ‘11’ or ‘tt’ as part of the

Password)

 Can not be the same as a previous Password used password in the iSupplier Portal.

 Can not contain your user’s Username or other Username.

( 9 ) In the “Re-enter New Password” field, enter the new password again.

Note: This field is case sensitive.

( 10 ) Click the “Submit” button to continue. The iSupplier Portal Home Tab will then be displayed.

1.2. RECOVER USER NAME AND PASSWORD – LOGIN ASSISTANCE
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In case that Password or Username are forgotten, use the Login Assistance from the “iSupplier Portal Login”

screen to request a new Password or recover your Username.

( 1 ) On the login screen, click on the “Login Assistance” hyperlink. The following screen will appear

( 2 ) On the “Login Assistance” screen, request a new password by completing the instructions in the “Forgot

Password” section.

( 3 ) In the “Login Assistance” screen, recover your Username by completing the instructions in the “Forgot User

Name” section.

Option 1: Forgot Password
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( 4 ) In the “User Name” field, enter your User Name to access the iSupplier Portal.

( 5 ) Click on the “Forgot Password” button to reset your Password. This will prompt an email with instructions to

be sent automatically to the email address associated with the Username (this may take up to an hour).

( 6 ) The notification shows the “User Name” of the iSupplier user whose Password has been reset.

( 7 ) The notification will provide a temporary Password for the user.

( 8 ) Click on the “iSupplier Portal” hyperlink to access the iSupplier Portal. You will be taken automatically to the

“Change Password” screen.

( 9 ) In the “Current Password” field enter the temporary password provided in the “Password Reset Notification”

email.

( 10 ) Populate the “New Password” field and “Re-enter New Password” field. The password must have the

following characteristics:

 Must be a minimum of 8 characters in length

 Must have at least 1 number

 Must have at least 1 character

 Must not have repeating characters or numbers (i.e. it can not have ‘11’ or ‘tt’ as part of the

Password)

 Can not be the same as any Password previously used in the iSupplier Portal.

 It can not contain the user’s Username.

( 11 ) Click on the “Submit” button. The “Oracle Application Home Page” will be shown.
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Note: Alternatively you can contact the iSupplier Portal Security Administrator within your company to request the

change of your password.

Option 2: Forgot User Name

( 4 ) In the “Email” field, enter the email address associated with your account.

( 5 ) Click on the “Forgot User Name” button. Your User Name will be emailed to you.

( 6 ) The notification shows the “User Name” of the iSupplier user.

Note: At this point you can either login to the Portal or reset your password. Follow the step below to

perform one of these actions.

( 7 ) Alternatively, access the Portal by clicking on the “Login” hyperlink.

( 8 ) Alternatively, reset your password by clicking on the “Reset Password” hyperlink. The “Reset Password”

screen will be displayed.
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( 9 ) In the “User Name” field enter your User Name.

( 10 ) Populate the “Password” field and “Confirm Your Password” field. The Password must have the following

characteristics:

 Must be a Minimum of 8 characters in length.

 Must have at least 1 number.

 Must have at least 1 character.

 Can not have repeating characters or numbers. (i.e. it can not have ‘11’ or ‘tt’ as part of the

Password)

 Can not be the same as a previous Password used in the iSupplier Portal.

 Can not contain you user’s Username or other Username.

( 11 ) Click on the “Confirm Password” button. A “Confirmation” message display to signify that the Password has

been reset.
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1.3. DEFINE MAIN PREFERENCES

Once you are logged in the iSupplier Portal, you can change your password at any time by clicking on the

“Preferences” hyperlink in the “Oracle Application Home Page” or any of the iSupplier tabs in the menu options in

the top right corner of the screen.

( 1 ) In the “Oracle Application Home Page” click on the “Preferences” hyperlink. This will take you to the

“General Preferences” screen. This screen shows the following sections:

 The “Languages” section allows you to set the preferred language to be used in the Portal; the choices are

English, Spanish or Arabic.

Note: Notifications will be received in the selected language. However, if the selected language is Arabic, the

Notifications are sent in English.

 The “Regional” section allows you to set preferences for the display of information in the Portal in a format

that is familiar to you based on the Region that you are located. The fields you can customize are: the

Country, Date Format, Time Zone, Number Format and Currency.

 The “Change password” section allows you to change your password at any time.

 The “Start page” section allows you to set the iSupplier responsibility that will display when you first login into

iSupplier Portal if you have multiple responsibilities within the Portal. If you only have one responsibility, that

will be displayed as the default and there will be no other choices in the drop down menu.

 The “Notifications” section allows you to set preferences to receive your notification.
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1.3.1. CHANGE PASSWORD

In the “Change Password” section you can change your password at any time by following the steps outlined

below.

( 1 ) In the “Old Password” field, enter your current password.

( 2 ) In the “New Password” field, enter your desired password.

( 3 ) In the “Repeat Password” field, rewrite your new password.

Note: Passwords are case sensitive.

Note: iSupplier password must have the following characteristics:

 Must be a Minimum of 8 characters in length.

 Must have at least 1 number.

 Must have at least 1 character.

 Can not have repeating characters or numbers. (i.e. it can not have ‘11’ or ‘tt’ as part of the

Password)

 Can not be the same as a previous Password used Password in the iSupplier Portal.

 Can not contain you user’s Username or other Username.

( 4 ) Save any changes by clicking on the “Apply” button.
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1.3.2. NOTIFICATIONS SETTINGS

In the “Notifications” section you can select how you want to receive your e-mail notifications. This setting does

not affect whether notifications are generated or displayed in the iSupplier Portal. For further details about

notifications, see section 3. - Notifications

IMPORTANT: CRC recommends to select the “HTML mail with attachments” e-mail notification style.
Selecting any other e-mail notification style could mean that you will NOT receive email notifications
correctly. However, all Supplier notifications are being managed and displayed within the iSupplier
Portal, even if you have chosen the “Disabled” or “Do not send me mail” style.

( 1 ) From the “Email Style” dropdown menu, select one of the following e-mail notification style to receive

notifications in the email account associated with your user account in the iSupplier Portal.

E-mail Notification Style Description

Disabled Do not select this option.

Do not send me mail

iSupplier user will not receive notifications to the email account associated
with the user account in the iSupplier Portal. However, the notifications are
received and shown within the iSupplier Portal in the “Worklist” section in the
“Oracle Application Home” Page.

HTML mail Email notifications are received in HTML without any attachments.

HTML mail with
attachments

Email notifications are received in HTML with an attached link to the
“Notification Details” screen.

HTML Summary Email
Email notifications are received in HTML with a summary of all the open
notifications the User.

Plain text mail Email notifications are received in plain text without any attachments.

Plain text mail with HTML
attachments

Email notifications are received in plain text with an attached link to the
“Notification Details” screen.

Plain Text Summary mail
Email Notifications are received in plain text with a summary of all the open
notifications the User.

( 2 ) Save any changes by clicking on the “Apply” button.



CALIFORNIA RESOURCES CORPORATION AND ITS AFFILIATES (COLLECTIVELY, CRC)

User Guide – Overview to Access, Passwords, Navigation
and Notifications

Version 1.0

December 1, 2014

Intellectual property restrictions. CRC proprietary information. Page 15 of 39

2. ORACLE APPLICATION HOME PAGE

The “Oracle Application Home Page” screen provides access to the responsibilities assigned to the user, and also

shows and provide access to the latest notifications.

2.1. ACCESS TO A SPECIFIC RESPONSIBILITY

Once the user has logged in to the iSupplier Portal, the “Oracle Application Home Page” screen will be displayed

only if more than one responsibility has been assigned to the user. Otherwise, the iSupplier “Home” tab will be

shown immediately. The “Oracle Application Home Page” screen contains two main sections.

( 1 ) The “Worklist” panel shows the most recent notifications. Access the full list of notifications by clicking on the

“Full List” button. If there are no notifications listed, no transactions are in progress. For further information

regarding notifications, see the section 3. - Notifications.

( 2 ) The “Main Menu” panel, also called the “Navigator” panel shows all of your assigned responsibilities. Access

the desired functionality by clicking on the applicable responsibility hyperlink. If you do not see any hyperlinks,

please contact the iSupplier Portal Security Administrator in your company.

Note: If the User only has one responsibility the “Home” tab screen for that responsibility will automatically

be displayed.
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2.2. RESPONSIBILITIES AVAILABLE FOR ISUPPLIER PORTAL USERS

There are five different responsibilities used in navigating the iSupplier Portal. Access will be granted according to

the responsibilities assigned to you.

Responsibilities Description Assign To

Supplier Security

Administrator

Administrate Supplier user access and
Supplier profile data. This responsibility
allows the user to access the “Admin” tab.

 Only iSupplier Portal Security
Administrator and an alternate.

Supplier User - Registration Temporary responsibility to complete the
Supplier registration and qualification
process. This responsibility allows the user
to access the “Negotiation” tab and
“Admin” tab.

 iSupplier Portal Security
Administrator.

 User who will be responsible for
performing the Supplier
registration and qualification
process.

Supplier User - Full View View all the information available in the
iSupplier Portal. This responsibility allows
the user to access all available tabs within
the portal.

 iSupplier Portal Security
Administrator.

 User who needs to view
information but does not have
the authority to enter data on
behalf of the Supplier in the
iSupplier Portal.

Supplier User - Transactions Perform actions related to all the processes
available in the iSupplier Portal except
administering Supplier users and Supplier
profile data. This responsibility allows the
user to access all available tabs within the
portal.

 iSupplier Portal Security
Administrator.

 User who needs to view the
information and has the
authority to enter data on behalf
of the Supplier.

Supplier User - Finance View View invoices and payment information.
This responsibility allows the user to access
the “Order” tab, “Finance” tab and
“Admin” tab.

 iSupplier Portal Security
Administrator.

 User who only needs to view
purchasing documents, invoices
and payments.

Supplier User - Invoicing Create/view invoices and credit memos,
and also view payment information. This
responsibility allows the user to access the
“Order” tab, “Finance” tab and “Admin”
tab.

 •iSupplier Portal security
Administrator.

 User who only needs to view
purchasing documents, invoices
and payments, and also has the
authority to create invoices and
credit memos on behalf of the
Supplier.
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3. NOTIFICATIONS

Notifications are automatically sent from the system to a Supplier (or a specific Supplier’s contact) to notify them

that:

 A specific event has been executed by CRC and no action is required from the Supplier (e.g. payments).

 A specific event has been executed by CRC and an action is required from the Supplier (e.g.

acknowledgement required).

Note: Periodically reminders are sent until the action is completed.

The appropriate CRC personnel will receive notifications when a Supplier executes an action through the iSupplier

Portal.

IMPORTANT: For automatic notifications the email sender will be “CRC – Notification” not a specific
person. If you do not receive a notification in your mailbox please check your mailbox spam, trash or
delete folders to see if it might have been filtered by your company spam filtering services. Make sure
to set “CRC – Notification” as a valid email sender to avoid any issue for subsequent notifications.
Yahoo and Hotmail email account users might NOT receive some notifications correctly. If an email
notification is showing an error message, login into the iSupplier Portal Home Tab – Notification Table
to review the notification there.

The main notifications a Supplier might receive are:

Process Supplier Action Key Notifications

iSupplier Portal User

Administration

 Administrate iSupplier Portal users  Confirmation of registration

 Username look up

 Password reset

Registration  View and Update Supplier Profile
data

 Confirmation of registration

Pre-Qualification Respond to:

 Request for Information (RFI)
 Pre-Qualification

Questionnaire

 Invitation to qualification event

 Qualification event closed

Sourcing Respond to:

 Request for Information (RFI)
 Pre-Screening
 Technical Evaluation

 Request for Quotation (RFQ)
 Commercial Evaluation

 Auction

 Invitation to negotiation event

 Negotiation event opened to bid

 Negotiation event extended time to
bid

 Negotiation event closed to bid

 Negotiation event amendment

 Negotiation event cancelled

Purchasing  View and acknowledge purchasing
documents, including Terms and
Conditions

 For Your Review

 Standard Purchase Order requires
your acceptance.

Contractual Deliverables  View and submit contractual
deliverables

 Deliverable is overdue

 Deliverable status change

Shipments  View, create and cancel Advance
Shipment Notice (ASN)

N/A
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Process Supplier Action Key Notifications

Receiving and Rejections  View receipts and returns

 View Consignment inventory

 View Supplier items

N/A

Performance Monitoring View and submit purchasing document
data by using a Request for
Information (RFI), related to:

 Objectives

 Non Conformities

 Performance Scorecards

 Invitation to objectives event

 Invitation to non conformity event

 Invitation to performance scorecard
event

View and Submit Purchasing Document
data related to:

 Issues

 Quality Meetings

 Deliverable is overdue

 Deliverable status change

Invoicing  View Invoices N/A

Payments  View Payments  Payment remittance advices

3.1. TYPES OF NOTIFICATIONS

iSupplier users simultaneously receive notifications by:

Option 1: System generated email (Sender: “CRC – Notifications”) to the email account associated with the user

account in the iSupplier Portal. The following screenshot is an example of an email notification.

( 1 ) To respond to a notification, click on the applicable hyperlink to access the iSupplier Portal. In the example

above click on the “Negotiation Details” hyperlink and go to the corresponding screen to take the appropriate

action.

Note: Clicking on the hyperlink will bring you to the iSupplier Portal “Login” screen.
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Note: Notifications can have additional links to access specific documentation within the Portal. Go to the

section 3.2. - View Notification Details to learn about the notification’s details.

Option 2: Oracle notifications are shown within the iSupplier Portal in the “Worklist” section in the “Oracle

Application Home” Page. They also are shown in the “Notifications” section in the “Home” tab.

( 1 ) To display all the notifications, click on the “Full List” button.

( 2 ) Click on the “Go” button. As needed use the “View” dropdown menu to select different view (i.e. Open

Notifications, FYI Notifications, and To Do Notifications). The screen will then display the notifications

according to the selection.

( 3 ) The “From” column shows who sent the notification from CRC. The name is necessary to know when making

any inquiry to CRC’s Supplier Help Desk regarding the notification.

( 4 ) The “Type” column shows the notification type, this is an internal iSupplier Portal classification.

( 5 ) The “Subject” column shows the subject of the notification. In general, it provides the transaction number and

indicates if the notification is for your information or if an action is required. To see the details of a

notification, click on the “Notification Subject” hyperlink.

Note: Examples of these messages are:

 Action to be taken (e.g.: ‘You are invited… ‘or ‘…will be due in 2 weeks’).

 Document type (e.g. RFQ or Deliverable).

 Document number or document related (i.e. RFQ 19001 or Blanket Purchasing Agreement

210000001518).

( 6 ) The “Sent” column shows the date when the notification was generated.

( 7 ) The “Due” column shows the due date for any required action to take place.
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3.2. VIEW NOTIFICATIONS DETAILS

Notice that the notifications received either through an email or the iSupplier Portal has the same sections, which are explained below.

Email Notification Oracle Notification

( 1 ) The “Notification details” section shows the general data regarding the notification including who sent the notification, important dates associated with

the event and the subject matter.

 The “From” field identifies the CRC contact who initiated the notification. The contact name is important to have when making any inquiry to CRC’s

Supplier Help Desk regarding the notification.

 The “Number” field identifies the event related to the notification. This number is necessary for searching for details of the event related to the

notification in the iSupplier Portal.

( 2 ) The “Message body” section shows detailed information regarding the event and required actions. If applicable, there will be hyperlinks to access a

specific screen or transaction in the iSupplier Portal.

( 3 ) If applicable, the “Action History” table will be displayed with all the actions taken related to this event. (Supplier and CRC actions).

( 4 ) If applicable, the “Response” section will be shown. This section is for information purposes only. It is included to make the Supplier aware that a

Response will be required for this notification. Do not use this section to submit a response. Also, do not click on the “Actions” button on the notifications.

To accept or reject documents, access the “CRC Registered Supplier webpage” and follow the User Guide Instructions provided for the respective

notification type.
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3.3. SUPPLIER ACTIONS ACCORDING TO THE NOTIFICATION RECEIVED

The following table shows the respective User Guide to use for each function within the iSupplier Portal and

notification type if there is one. These User Guides describe how to access the key iSupplier Portal functionality to

complete the required action.

Process Key Notifications Supplier Action – User Guide to use

iSupplier Portal

User

Administration

 Username look up

 Password reset

See Sections:
1.1. Login to the iSupplier Portal.
1.2. Get User Name or Reset Password.

Registration  Invitation to Register  User Guide - Submit Prospective Supplier
Registration Form

Registration  Confirmation of registration  View and Update the Organization
Information. See section 4.7. - Admin Tab

Pre-Qualification  Invitation to qualification event

 Qualification event closed

 User Guide - Respond to Request for
Information (RFI)

Sourcing  Invitation to negotiation event

 Negotiation event opened to bid

 Negotiation event extended to bid

 Negotiation event closed to bid

 Negotiation event amendment

 Negotiation event cancelled

 User Guide – Quote Request for Quotation
(RFQ)

 User Guide – Respond to Request for
Information (RFI)

Purchasing  For Your Review

 Standard Purchase Order requires
your acceptance.

 User Guide – View and Accept Purchasing
Document

Contractual
Deliverable

 Deliverable is overdue

 Deliverable status change

 User Guide – View and/or Submit Contractual
Deliverables

Shipments N/A  User Guide – View and Create Advance
Shipping Notices.

Receiving and
Rejections

N/A  View receipts and returns (User Guide – View
and Create Advance Shipping Notices)

 View Consignment inventory

 View Supplier items

Performance
Monitoring

 Invitation to objectives event

 Invitation to non conformity event

 Invitation to performance scorecard
event

View and submit purchasing document data by
using a Request for Information (RFI), related to:

 Objectives

 Non Conformities

 Performance Scorecards

 Deliverable is overdue

 Deliverable status change

 User Guide - View and Submit Contractual
Deliverables

Invoicing N/A  User Guide- View Invoices and Payments

Payments  Payment remittance advices  User Guide- View Invoices and Payments
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3.4. NOTIFICATION DELEGATION – GRANT WORKLIST ACCESS

You can set up other iSupplier Portal users within your company so that they can access your work list in the

iSupplier Portal. Notification delegation allows sharing all or just specific notifications with someone else.

( 1 ) In the iSupplier Portal “Home” Tab in the “Notifications” section, find the list of your pending notifications. To

display all the notifications, click on the “Full List” button.

( 2 ) Click on the “Worklist Access” hyperlink at the bottom of the screen.
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( 3 ) Click on the “Grant Worklist Access” button.

( 4 ) In the “Name” field, select the iSupplier Portal user within your company that you would like to grant access

to your worklist.

( 5 ) In the “Description” field, write any description to indicate the reason, purpose or scope of the delegation.

( 6 ) In the “Start Date” field click on the “Calendar” icon to select the effective date to grant the access.

( 7 ) In the “End Date” field, click on the “Calendar” icon to select the effective date to cancel the access only if you

want to limit the access to a certain period of time.

( 8 ) In the “Grant Access to” section, select from the following:

 “All Item Types” radio button: To share all your notifications with someone else.

 “Selected Item Types” radio button: To specify which notification will be shared.

( 9 ) If you have not granted access to All Item Types, to specify which types of notifications will be shared, in the

“Available Item Types” box, select the notification types to share by clicking on the appropriate types.

( 10 ) Click on the “Move Arrow” icon to transfer the item to the “Selected Item Types” box.

( 11 ) Once you have finished selecting the items, click on the “Apply” button. The “Worklist Access” screen will

show the new setup.

( 12 ) You can also update the “Worklist Access” by clicking on the “Pencil” icon in the “Update” column.

( 13 ) You can remove a contact from the “Worklist Access” by clicking on the “Trash can” icon in the “Delete”

column.
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3.5. NOTIFICATION DELEGATION – VACATION RULES

When applicable, set the “Vacation Rules” to auto respond or redirect notifications within your organization

during times when you will not be available to respond to notifications.

( 1 ) In the iSupplier Portal “Home” Tab in the “Notifications” section, find the list of your pending notifications. To

display all the notifications, click on the “Full List” button.

( 2 ) Click on the “Vacation Rules” hyperlink. The following screen will appear.

( 3 ) Click on the “Create Rule” button.

( 4 ) Click in the “Item Type” dropdown menu and select the type of notification that will be rerouted. For this

example, a specific notification type has been selected to activate the Vacation Rule.

Note: You can set the rule for a specific item or all items. If you select all items, skip to step 8.

( 5 ) Click the “Next” button. The “Vacation Rules: Notification” screen will be displayed.
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( 6 ) In the “Notification” option, select:

 “All”: To delegate/transfer all notifications related to the selected notification type.

 “Select”: To delegate/transfer selected notifications, click on the “Magnifying Glass” icon to look up the

specific notifications. Use the “%” symbol to broaden the range of results.

( 7 ) Click on the “Next” button.

( 8 ) In the “Start Date” field, select the effective date to implement the rule by clicking on the “Calendar” icon.

( 9 ) In the “End Date” field, select the effective date to cancel the rule by clicking on the “Calendar” icon.

( 10 ) In the “Message” field you can write a message that will display with each routed notification.

( 11 ) In the “Reassign” field, click on the “Magnifying Glass” icon to look up the iSupplier Portal user who you are

requesting to receive the selected notifications.

 In the “Reassign” section, select:

 “Delegate your response” radio button: Select this option if you want to give another user authority

to respond the notifications on your behalf but you want to retain ownership of the notification. For

example, a manager might delegate all requests to an assistant.

 “Transfer notification ownership” radio button: Select this option to give another user complete

ownership and responsibility for the notification. For example, use this option if you are not the

correct contact for the specific notification and you want to send it to the correct recipient or to

another recipient for resolution.

( 12 ) Optionally, select the “Deliver notifications to me regardless of any general rules” radio button to leave the

notification in your “Worklist” with no automatic processing. Define a rule with this action to exclude a certain

subset of notifications from a more encompassing rule. Click on the “Apply” button. The “Vacation Rules”

screen will then show the new delegations.

( 13 ) To update the access attributes of the “Vacation Rules” click on the “Pencil” icon in the “Update” column.

( 14 ) To remove the access click on the “Trash can” icon in the “Delete” column.
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4. NAVIGATION

4.1. HOME TAB

If more than one type of responsibility has been assigned, select the appropriate responsibility on the “Oracle

Applications Home Page” to accomplish the task that has been assigned. If only one responsibility has been

assigned, the iSupplier portal “Home” Tab screen will be shown immediately and there will be no other

responsibilities displayed

Note: Some sections will only appear if there are transactions that are in progress or that have taken place.

The responsibility being used will dictate which tabs appear.

( 1 ) The “Home” tabs allow quickly access to others functionalities, such as Orders, Shipments, Negotiations,

Finance, Products, Admin and each of their related functionalities.

( 2 ) The “Search” section allows different types of searches to be selected by using the dropdown menu (Purchase

orders, Shipments, Invoices, and Payments). In the empty box, enter the document number or the “%”

symbol. Use the wildcard “%” symbol to broaden the range of results.

( 3 ) The “Notifications” section shows the notifications waiting for your review. Some notifications are view-only,

while other notifications require action. To open and view your notifications, click the “Subject” hyperlink.

Click on the “Full List” button to display all notifications.

( 4 ) The “Responses to Negotiations” section shows the list of draft and active responses to open sourcing events.

Click the “Response” hyperlink number to open and view a response. Click on the “Full List” button to display

all responses.

( 5 ) The “Orders at a Glance” section shows the list of the most recent purchasing documents (PO). Click a

purchase order number to view purchase order details. Click the Full List button to display all purchasing

documents.

( 6 ) The “Quick links” section shows the shortcuts to the main functionalities and web pages. Click any hyperlink

to go directly to a screen.

Note: If applicable, the “Shipments at a Glance” list will appear in the iSupplier Portal “Home” tab. This is a

list of shipments. Click a “Shipment number” hyperlink to open and view shipment details. Click on the “Full

List” button to display all shipments.



CALIFORNIA RESOURCES CORPORATION AND ITS AFFILIATES (COLLECTIVELY, CRC)

User Guide – Overview to Access, Passwords, Navigation
and Notifications

Version 1.0

December 1, 2014

Intellectual property restrictions. CRC proprietary information. Page 27 of 39

4.1.1. SEARCH OPTION

The iSupplier Portal provides extensive search criteria on all screens to help retrieve information. Broaden the

searching results by using “%” symbol in any searching criteria. Once the results are displayed, sort them by

clicking any column headings. Follow the steps outlined below to conduct a quick search from the “Home” tab.

( 1 ) Choose the type of search from the dropdown menu (i.e.: Purchase orders, Shipments, Invoices, and

Payments).

( 2 ) In the empty box, enter the document number or “%” symbol.

( 3 ) Click on the “Go” button to begin the search. The required information will appear according to the search

criteria.

4.2. ORDERS TAB

The “Orders” tab shows all of the orders generated in the iSupplier Portal between CRC and the Supplier. Supplier

will be able to view or print the purchasing documents as well as electronically execute the purchasing document

acceptance in the “Orders” tab. To get more information about how to use the iSupplier Portal “Orders” tab, go to

the “User Guide – View and Accept Purchasing Documents” or the “User Guide – View and Submit Contractual

Deliverables”.



CALIFORNIA RESOURCES CORPORATION AND ITS AFFILIATES (COLLECTIVELY, CRC)

User Guide – Overview to Access, Passwords, Navigation
and Notifications

Version 1.0

December 1, 2014

Intellectual property restrictions. CRC proprietary information. Page 28 of 39

4.3. SHIPMENTS TAB

For more information about how to access the iSupplier Portal “Shipments” tab, view the “User Guide - View and

Create Advance Shipping Notices”

4.4. NEGOTIATIONS TAB

For more information about how to access the iSupplier Portal “Negotiation” tab, view the “User Guide – Respond

to Request for Information (RFI)” or “User Guide – Quote Request for Quotation (RFQ)”

4.5. FINANCE TAB

For more information about how to access the iSupplier Portal “Finance” tab, view the “User Guide – View

Invoices and Payments”

4.6. PRODUCT TAB

The iSupplier Portal “Product” tab shows all of the transactions related to specific products that your company

populated in the iSupplier Portal.

4.6.1. VIEW PRODUCT INFORMATION

Access the “Product” tab to view and track all of CRC’s transactions related to your company’s products.

( 1 ) In the iSupplier portal “Home” page, click on the “Product” tab.
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( 2 ) In the “Product” tab click on the “Supplier Items” hyperlink.

( 3 ) In the “Simple Search” section, populate search criteria and click on the “Go” button to access applicable

product information.

( 4 ) The “Supplier Item” column shows Supplier item number.

( 5 ) The “Item” column shows CRC item catalog number.

( 6 ) The “Cross Reference” columns allow access to specific Orders, Receipts, Returns, etc, related to a specific

product.

4.6.2. VIEW CONSIGNED INVENTORY

The “Consigned Inventory” sub-tab allows you to track and view all of CRC’s transactions related to your

company’s consigned products under the categories: On-hand, Shipments, Advices, Receipt and Transactions.

( 1 ) In the “Product” tab click on the “Consigned Inventory” hyperlink.

( 2 ) Click on the “Consigned Inventory” hyperlink.

( 3 ) In the “Simple Search” section populate the search criteria and click on the “Go” button to access applicable

product information.

( 4 ) The “Supplier Item” column shows Supplier item number.

( 5 ) The “Item” column shows CRC’s item catalog number.

( 6 ) The “Cross reference” columns shows links to access the specific Orders, Receipts, Returns, etc, related to a

specific product.
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4.6.3. VIEW CONSIGNED INVENTORY AGING

The “Consigned Inventory” sub-tab also allows you to view the number of days an item has aged through CRC’s

transactions related to your company’s consigned products.

( 1 ) In the “Product” tab click on the “Consigned Inventory” hyperlink.

( 2 ) Click on the “Consigned Inventory Aging” hyperlink.

( 3 ) In the “View” dropdown menu, select the number of days the item has aged. Then click on the “Go” button to

display the information.

( 4 ) You can also click on the “Export” button to export aged line items to analyze the information outside of the

iSupplier Portal.

( 5 ) The “Line item” section shows the detailed information about an aged item.

4.7. ADMIN TAB

The “Admin” Tab is where you can view and manage key company profile details used to establish or maintain a

business relationship with CRC. This profile information includes organizational data, addresses, contacts, banking

details and products and services.

IMPORTANT: Information in the “Admin” Tab can only be entered or updated by the Supplier during
the registration and pre-qualification process. Once the pre-qualification process has been completed,
this data can only be viewed. If the Supplier identifies any data that needs to be added, modified or
removed, please use the Supplier Registration Information Modification Form available at
http://iSuppliersupport.CRC.com to submit any changes.
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4.7.1. ACCESS ADMIN TAB - VIEW GENERAL INFORMATION

The “General” screen shows your company’s relevant information. Click on the “Admin” tab in the iSupplier portal

“Home” page. Then, the “General” screen will appear.

( 1 ) The “Profile Management” panel shows the profile section. Access each section by clicking on the respective

hyperlink.

( 2 ) The “General” section shows your company’s basic information.

( 3 ) The “Attachments” section shows any attachments provided by the Supplier. Specific attachments can be

accessed by clicking on the attachment “Title” hyperlink.

Note: Delete an attachment by clicking the “Trash can” icon in the “Delete” column.

IMPORTANT: Only users that have been assigned the Supplier Security Administrator and Supplier User
– Transactions responsibilities, can view the “Attachments” section.
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4.7.2. SEARCH AND UPDATE ATTACHMENTS

In the “Attachment” section view, update and delete attachments.

( 1 ) In the “Title” field, enter the name of the attachment or the “%” symbol to broaden the search.

( 2 ) Click on the “Go” button to see the list of attachments that met the search criteria.

Note: Increase the search options by clicking on the “Show More Search Options” hyperlink.

( 3 ) View specific attachment content by clicking on the attachment “Title” hyperlink.

( 4 ) The “Category” field shows the type of attachment.

( 5 ) Update an attachment by clicking the “Pencil” icon in the “Update” column. The following screen will appear.

( 6 ) In the “Title” field, enter the attachment name.

( 7 ) In the “Description” field, enter a useful description to describe the attachment content and purpose.

( 8 ) In the “Category” dropdown menu, choose “From Supplier”.

( 9 ) Click on the “Browse” button to locate the file to be uploaded.

( 10 ) Click on the “Apply” button to submit the changes.



CALIFORNIA RESOURCES CORPORATION AND ITS AFFILIATES (COLLECTIVELY, CRC)

User Guide – Overview to Access, Passwords, Navigation
and Notifications

Version 1.0

December 1, 2014

Intellectual property restrictions. CRC proprietary information. Page 33 of 39

4.7.3. ADD ATTACHMENT

In the “General” screen, add new attachments to your profile as needed. Attachments can be documents

pertinent to your relationship with CRC.

( 1 ) Click on the “Add Attachment” button. The following screen will appear.

( 2 ) In the “Title” field, enter the attachment name.

( 3 ) In the “Description” field, enter a useful description to describe the attachment content and purpose.

( 4 ) In the “Category” dropdown, choose “From Supplier”.

( 5 ) Select the “Type” radio button:

 File: Click on the “Browse” button to locate the file to be uploaded.

 URL: In the “URL” field, enter the URL address.

 Text: In the “Text” field, enter the appropriate text.

( 6 ) Click on the “Apply” button to upload the attachment.

Note: Click on the “Add Another” button to repeat the process for additional attachments.
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4.7.4. VIEW AND UPDATE THE ORGANIZATION INFORMATION

In the “Organization” screen, enter high-level details about your company. To access the organization details, click

on the “Admin” tab.

IMPORTANT: This information can be only entered or updated by the Supplier during the registration
and qualification process using the responsibility, Supplier user – Registration.

IMPORTANT: Use capital letters to populate the fields.

( 1 ) Click on the “Organization” hyperlink in the “Profile Management” navigation panel.

( 2 ) In the “Organization” section view and enter your organization details. Populate fields as needed. The Legal

Structure field cannot be modified.

( 3 ) In the “Total Employees” section view and enter your employee information. Populate all fields.

( 4 ) In the “Tax and Financial Information” section, enter the Tax Registration No., Tax ID., etc. Populate fields as

needed.

Note: The Taxpayer ID field cannot be modified.
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4.7.5. VIEW THE ADDRESS BOOK

The “Address Book” screen provides information about your company’s registered addresses for requesting

information or quotations, ordering materials and services, and receiving payments.

( 1 ) Click on the “Address Book” hyperlink in the “Profile Management” navigation panel. The general

information about the company’s address will appear.

( 2 ) To view a detailed information about the company’s address, click on the on the “Pencil” icon in the “Update”

column. The following screen will appear.

Note: This is just an information screen; you will not be able to modify the information.
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4.7.6. VIEW THE CONTACT DIRECTORY

The “Contact Directory” screen provides information about your company’s registered personnel and the iSupplier

Portal users.

IMPORTANT: This information can be entered or updated by the Supplier during the registration and
pre-qualification process using the responsibility: Supplier User - Registration. It also can be updated by
the Supplier Security Administrator in your company at any time. See additional information in the User
Guide – Administrate Users – Security Administrator

( 1 ) Click on the “Contact Directory” hyperlink in the “Profile Management” navigation panel. The general

information about the company’s contacts will appear.

( 2 ) The “Active Contacts” section shows your active contacts key data.

 See a contact’s detail information by clicking on the “Pencil” icon in the “Update” column.

 See a contact’s addresses by clicking on the “Addresses” icon.

( 3 ) The “Inactive Contact” section shows any contacts that are inactive.

4.7.7. VIEW PRODUCTS AND SERVICES

The “Products and Services” screen provides information about your company’s registered products and services

according to CRC-selected UNSPSC (United Nations Standard Products and Services Code) codes and descriptions

at the class level. For more information regarding UNSPSC codes, visit www.unspsc.org.

IMPORTANT: This information can be entered or updated by the Supplier during the registration and
pre-qualification process using the responsibility, Supplier User - Registration. See additional
information in the User Guide – Respond to Request for Information (RFI).

( 1 ) In the “Profile Management” navigation panel, click on the “Products and Services” hyperlink.

( 2 ) The “Code” column shows Product or services with UNSPSC codes at the class level.

( 3 ) The “Products and Services” column shows Products or services with UNSPSC description at the class level

(Segment – Family – Class Description).
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4.7.8. VIEW BANKING DETAILS

The “Banking Details” screen provides information about your company’s bank accounts that your company has

identified to be used by CRC to send electronic payments. Bank accounts can be associated with specific addresses.

There are two recommended options to view bank accounts.

IMPORTANT: Banking accounts details can only be created and modified by CRC personnel based on
verification of Supplier-provided information.

Option 1: View all Accounts.

( 1 ) In the “Profile Management” navigation panel, click on the “Banking Details” hyperlink.

( 2 ) In the “View” dropdown menu, select “All Accounts”.

Note: If “General Accounts” is selected in the “View” field, bank accounts without any associated addresses

will be shown.

( 3 ) Click on the “Go” button. The primary data for all bank accounts will be shown.

( 4 ) To view details about a specific bank account, identify the account and click on the “Pencil” icon in the

“Update” column. The following screen will appear.
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( 5 ) The “Bank” section shows bank’s detailed information.

( 6 ) The “Address” section shows bank’s address.

( 7 ) The “Branch” section shows detailed information about the bank’s branch.

( 8 ) The “Address” section shows detailed information about the bank branch’s address.

( 9 ) The “Bank Account” section shows detailed information about the bank account.

Option 2: View the bank accounts associated with a specific address

( 1 ) In the “View” dropdown menu, select “All Assignments”.

Note: If “General Accounts” is selected in the “View” field, bank accounts without any associated addresses

will be shown.

( 2 ) Click on the “Go” button. All addresses and associated bank accounts will be shown.
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4.7.9. VIEW PAYMENTS AND INVOICING PREFERENCES

The “Payment and Invoicing” screen provides information about your company’s payment and invoicing. Please

note that invoices and payments will be processed according to the specific purchasing document terms and

conditions.

IMPORTANT: This information can be entered or updated by the Supplier during the registration and
qualification process using the responsibility Supplier User - Registration.

( 1 ) In the “Profile Management” navigation panel, click on the “Payment & Invoicing” hyperlink.

( 2 ) The “Search” section allows you to search information about your company’s payment and invoicing

preferences. Search by entering the address name in the “Address Name” field and clicking on the “Go”

button for access to the preferences related to that specific address.

Note: Use “%” to access all addresses.

( 3 ) The “Address Name” column shows the list of addresses. The payment and invoicing preferences is

established for each address.

( 4 ) The “Payment Method” column shows the method for payment. The different methods are shown below.

Payment Method Description

CRC ZZZ Payment made by international banks by CRC’s international operating units

CRC CHECK Paper check to be sent via mail

CRC EFT (Int’l local banks) Payment made from local bank by CRC’s international operating units

CRC ACH Electronic payments from a US bank to a US bank

CRC RECORDING ONLY For CRC’s internal use only

CRC CWT Foreign currency electronic payments from a US bank

CRC FWT US Dollar electronic payments from a US bank

( 5 ) The “Payment Currency” column shows the established currency for payments billed to the current address.

( 6 ) The “Invoice Currency” column shows the established currency for invoices billed to the current address.

( 7 ) The “Notification Method” column shows the method to receive the notifications (i.e.: by email, fax, print or

none)


